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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

 
DANGER

indicates that death or severe personal injury will result if proper precautions are not taken.
 

 
WARNING

indicates that death or severe personal injury may result if proper precautions are not taken.
 

 
CAUTION

indicates that minor personal injury can result if proper precautions are not taken.
 

 
NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

 
WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

 Siemens AG
Industry Sector
Postfach 48 48
90026 NÜRNBERG
GERMANY

 
Ⓟ 07/2013 Technical data subject to change

Copyright © Siemens AG 2013.
All rights reserved



Table of contents

1 General notes...............................................................................................................................................5
 1.1 General notes................................................................................................................................5
 1.2 Notes on the installation................................................................................................................9

2 STEP 7 Professional...................................................................................................................................11
 2.1 Security information.....................................................................................................................11
 2.2 Notes on use...............................................................................................................................12
 2.3 Editing devices and networks......................................................................................................15
 2.3.1 General information on devices and networks............................................................................15
 2.3.2 Use of modules on the S7-1200..................................................................................................15
 2.3.3 Replacing ET 200S positioning modules.....................................................................................16
 2.3.4 CP 343-2 on SIMATIC S7 Embedded Controller EC31-RTX......................................................16
 2.3.5 Notes on online and diagnostics..................................................................................................17
 2.3.6 Network components...................................................................................................................17
 2.3.6.1 Network components...................................................................................................................17
 2.4 Programming a PLC....................................................................................................................23
 2.4.1 General notes on PLC programming...........................................................................................23
 2.4.2 Instructions..................................................................................................................................26
 2.4.3 Testing the user program............................................................................................................29
 2.4.3.1 Testing with the watch table........................................................................................................29
 2.4.3.2 Testing with the force table..........................................................................................................29
 2.5 Technological functions...............................................................................................................30
 2.5.1 Notes on technological functions.................................................................................................30
 2.5.2 Notes on technological functions.................................................................................................34
 2.5.3 Notes on technological functions.................................................................................................34
 2.5.4 SIMATIC STEP 7 Easy Motion Control.......................................................................................34
 2.5.4.1 Notes on SIMATIC STEP 7 Easy Motion Control........................................................................34
 2.5.5 SIMATIC STEP 7 PID Professional.............................................................................................34
 2.5.5.1 Notes on SIMATIC STEP 7 PID Professional.............................................................................34

3 WinCC Basic...............................................................................................................................................35
 3.1 Security information.....................................................................................................................35
 3.2 Notes on use...............................................................................................................................36
 3.3 Migration......................................................................................................................................39
 3.4 Engineering System....................................................................................................................42
 3.4.1 Screens and Screen Objects.......................................................................................................42
 3.4.2 Tags and connections.................................................................................................................47
 3.4.3 Alarm system and alarm displays................................................................................................48
 3.4.4 System functions.........................................................................................................................49
 3.4.5 Recipes........................................................................................................................................49
 3.4.6 User administration......................................................................................................................50
 3.4.7 Communication............................................................................................................................50

Readme
Programming and Operating Manual, 07/2013,  3



 3.5 Compiling and loading.................................................................................................................53
 3.6 Runtime.......................................................................................................................................56
 3.6.1 Notes on operation in Runtime....................................................................................................56
 3.6.2 Notes on operation of panels in Runtime....................................................................................57
 3.7 HMI devices.................................................................................................................................58
 3.7.1 Notes on HMI devices.................................................................................................................58

 Index...........................................................................................................................................................61

Table of contents

Readme
4 Programming and Operating Manual, 07/2013,  



General notes 1
1.1 General notes

The information in this readme file supersedes statements made in other documents.

Read the following notes carefully because they include important information for installation 
and use. Read these notes prior to installation.

Functions for S7-1200 as of firmware version V4
In the information system for the TIA Portal V12 SP1, functions are documented for S7-1200 
as of firmware version V4 which are not yet available in the software.

Online operation in hibernate mode
We recommend that you do not use the two options "Hibernate" and "Sleep" in online operation; 
if you do, communication problems could occur. If necessary, adapt the computer's energy 
options.

Opening a project for the first time in TIA Portal V12 SP1
If you are opening your project for the first time in TIA Portal V12 SP1, right-click on the CPUs 
used in the project view and then select "Compile > Software (rebuild all blocks)" from the 
shortcut menu.

Installing new .Net versions or .Net service packs
● Close the TIA Portal before installing a new .Net version or a new .Net service pack on your 

programming device/PC.

● Restart the TIA Portal only after successful installation of the new .Net version or the 
new .Net service pack.

Opening a project in TIA Portal V11
When you open a version V11 project in TIA Portal version 12, you can add components that 
were subsequently supplied for the version V11 within the context of a Hardware Support 
Package (HSP) to the project. The project is then still compatible with TIA Portal version 11. 
If you now open this project in TIA Portal version 11, but this TIA Portal application has not 
been upgraded with the corresponding HSP, the respective component will not be supported 
in the project.
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Notes on handling
● If a project in the list of projects last used is located on a network drive that is not connected, 

you may experience delays when opening the "Project" menu.

● When you insert a CPU, you may need to wait for some time if the project editor is open at 
the same time. This generally takes longer when you insert the first CPU in a newly created 
project. To be able to continue working more quickly, you should close the project editor 
before inserting a CPU.

● The alarm "Application is not responding" may appear in Windows 7 with functions that 
take a long time to run (loading the CPU for example). If this occurs, wait until the function 
has correctly finished.

● If you have installed a Microsoft mouse with IntelliPoint, you may find that it superimposes 
components over the buttons of the title bar. If this is the case, uninstall the IntelliPoint 
software from Microsoft.

● Enabling the "Virtual Desktop" options with NVIDIA graphics cards can cause problems. In 
this case, disable the "nView virtual desktop manager" of your NVIDIA graphics driver.

Using the TIA Portal via a remote desktop
In principle, it is possible to use the TIA Portal via a remote desktop connection. During 
configuration, you should, however, avoid disconnecting the connection to the desktop client. 
In rare cases, this can lead to the software user interface being blocked.

If you experience this blockage, follow these steps on the desktop client.

1. Open the Windows Task-Manager and close the "rdpclip.exe" process.

2. Type in "rdpclip.exe" in the command prompt to restart the process.

Note that the current content of the clipboard will be lost. You can, however, then continue 
configuration as usual. To be on the safe side, you should restart the TIA Portal at the next 
opportunity.

Opening the TIA Portal multiple times
If you are running several applications of the TIA Portal and they continually become active in 
turn, you can briefly switch to another application or use the key combination <ALT+Tab> to 
solve the problem.

Note on SD cards
The SD cards have been formatted and set up by Siemens for use with S7-1200 and S7-1500 
modules. This format must not be overwritten; otherwise, the card will no longer be accepted 
by the modules. Formatting with Windows tools is therefore not permitted.

Behavior in case of open force job
Note that active force jobs is retained even after you have loaded a new project to the SD card. 
This means you should first delete the active force job before you remove an SD card from 
the CPU and before you overwrite the card in the PC with a new project. If you use an SD card 
with unknown content, you should format the SD card before the next download.

General notes
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Warnings on memory space with Windows XP (32-bit)
When you work with Windows XP (32-bit) for a long time, a memory space warning may appear 
which prompts you to save the current project and restart the TIA Portal. This can occur 
frequently in the case of an operating system with integrated graphics hardware. Disabling the 
graphics hardware acceleration may reduce the number of warnings. You can find the setting 
for this by clicking on the desktop and selecting "Properties > Settings > Advanced > 
Troubleshoot" by means of the right mouse button. In this dialog, move the "Hardware 
acceleration" slider to the far left (setting "None") and apply this setting.

Problems while shutting down Windows XP
If you experience problems shutting down the computer, make sure that the TIA Portal has 
closed completely.

1. In the shortcut menu, select the Task Manager from the shortcut menu on the Taskbar.

2. If you see the process "Siemens.Automation.ObjectFrame.FileStorage.Server.exe" in the 
"Processes" tab, wait until this process has closed.

3. Then you can shut down the computer.

Subnet addressing for CP 1613 and CP 1623 
CP 1613 and CP 1623 are communication modules with microprocessor. To ensure secure 
management of communication links, these are processed on the module. The protocol stack 
in your PC is used for diagnostic purposes (SNMP, DCP). To allow both protocol stacks (i.e. 
CP 1613/23 Firmware and CP 1613/23 NDIS access) access to the same partners, is 
recommended to place both stacks of a module in the same subnet.

Editing a device IP address
Do not use the address range from 192.168.x.241 to 192.168.x.250 when editing a device IP 
address. If necessary, this address range is automatically assigned by the system to a 
programming device. Depending on the subnet mask, this applies also for all network classes.

Migrating projects with the TIA Portal
After the migration of hardware configurations and program blocks from earlier automation 
solutions, first check the functionality of the migrated project before you use it in productive 
operation.

Working with TeleService
The TS Adapter IE Advanced is not available yet at the start of delivery of the TIA Portal V12 
SP1. Remote connections can only be configured as VPN connections with the TIA Portal V12 
SP1 after the start of delivery of the TS Adapter IE Advanced.

General notes
1.1 General notes
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Working with automatically synchronized network drives
Automatic synchronization after a network interruption can result in current (local) project data 
being stored as a "backup" on the network drive through user interactions. This could cause 
outdated project data to be loaded from the network drive when opening the project. For this 
reason, we do not recommend that you store TIA Portal projects on synchronized network 
drives. 

If, however, you do work on synchronized drives, you can continue working locally in the event 
of a network interruption. In this case, you must always ensure that the TIA Portal application 
is closed while data is synchronized. The synchronization itself must be implemented in such 
a way that the current (local) project data replaces the project data on the network drive. 

Entry of decimal places
With certain Windows language settings, it may occur that the entry of values with a comma 
as decimal place is not recognized (entering "1,23" leads to an error). Instead, use the 
international format ("1.23").

Access protection for memory cards in USB card readers
By improving the security mechanisms for online access and engineering of S7-1500 CPUs, 
the data storage on memory cards has been changed. For this reason, this version of STEP 
7 cannot evaluate the passwords of the configured protection level when reading project data 
from memory cards that is accessed via a USB card reader. The changed behavior affects the 
memory cards for CPUs of the S7-1200/1500 series. Therefore, use physical safeguards to 
protect critical project data on memory cards for these devices.

 

 Note

This restriction is not related to online access to devices or the know-how protection of 
program blocks.

 

Screen display
After long periods of work, it can happen in the case of certain computer configurations with 
Windows XP that parts of the TIA Portal interface are no longer updated. Reducing the graphic 
hardware acceleration can correct this problem. You can find the setting for this by clicking on 
the desktop and selecting "Properties > Settings > Advanced > Troubleshoot" by means of the 
right mouse button. In this dialog, move the "Hardware acceleration" slider to the far left (setting 
"None") and apply this setting.

Information on the TIA Portal in online support
Overview of the most relevant technical information and solutions for the TIA Portal in the 
industry online support.

Internet link: Auto-Hotspot

All information on service and support in the industry online support:

Internet link: Auto-Hotspot

General notes
1.1 General notes
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Here, you can also subscribe to the newsletter that provides you with latest information relating 
to your products.

Starting the TIA Portal
When you start the TIA Portal, Windows attempts to update the Certificate Revocation List 
(CRL) of "windowsupdate.com".

If no Internet connection is available and there are multiple DNS servers, a timeout may occur 
during the start of the TIA Portal.

FAQs on the TIA Portal
FAQs on the TIA Portal are available at http://support.automation.siemens.com. 

1.2 Notes on the installation

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Using the same versions of TIA Portal products
The TIA Portal products STEP 7 (incl. PLCSIM), WinCC and Startdrive must be upgraded to 
the same version (V12 SP1). If the versions are different, you will no longer be able to start 
the TIA Portal. Even uninstalling a product will not restore an operational status. Please ensure 
that you have the service packs for these products to hand before you start the installation. 
You can download the service packs from the Internet under http://
support.automation.siemens.com (http://support.automation.siemens.com/WW/llisapi.dll?
aktprim=99&lang=en&referer=%2fWW
%2f&func=cslib.csinfo2&siteid=csius&extranet=standard&viewreg=WW&groupid=4000002).

Target directory of the installation
Do not use any UNICODE characters (for example, Chinese characters) in the installation path.

Use of antivirus programs
During the installation, read and write access to already installed files is necessary. Some 
antivirus programs block this access. We therefore recommend that you disable antivirus 
programs during the installation of the TIA Portal and enable them again afterwards.

General notes
1.2 Notes on the installation
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Installation of STEP 7 Basic V12 and STEP 7 Professional V12 under Windows XP with Turkish regional 
and language options

Installation of STEP 7 Basic V12 and STEP 7 Professional V12 under Windows XP may be 
aborted if the regional and language options are set to Turkish. In this case change the regional 
and language options from Turkish to English or German.

1. Open the Control Panel under Windows with one of the following commands:

– "Start > Control Panel" (Start menu under Windows XP)

– "Start > Settings > Control Panel" (classic start menu)

2. Open the "Regional and Language Options".

3. Select the "Regional Options" tab.

4. Under "Standards and formats" select "German" or "English" in the drop-down list.

5. Click "Apply" and confirm with OK.

6. Restart your PC for the setting to become active. Now you can continue with the installation 
of STEP 7 Basic V12 and STEP 7 Professional V12.

7. After installation, you can revert the regional and language settings (as described in steps 
1 to 4) to Turkish.

Compatibility with V11
An empty V11.0.2.5 project with the name "TIA_Portal_Project_V11.0.2.5.ap11" is installed in 
the installation directory under ..\Portal V12\SampleProjects in order to allow TIA Portal V12 
to be opened in compatibility mode V11. This project must be copied to a local directory with 
full access before it can be used. For more information on this, refer to FAQ ID 66027369.

Installation of Startdrive V12
A prerequisite for the installation of Startdrive V12 is that STEP 7 V12 is installed beforehand.

Installation of the SIMATIC USB driver under Windows server 2003 R2 StdE SP2
An operating system alarm relating to the SIMATIC USB driver is issued on the operating 
system Windows Server 2003 R2 StdE SP2. This alarm must be acknowledged with "Yes" as 
soon as possible after the alarm has been issued. The alarm may be in the background and 
therefore may not be immediately visible. After a certain period of time, the setup continues 
with the next component. The SIMATIC USB drivers are then not installed and cannot be used.

General notes
1.2 Notes on the installation
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STEP 7 Professional 2
2.1 Security information

Upgrades and updates
Siemens provides automation and drive products with industrial security functions that support 
the secure operation of plants or machines. They are an important component in a holistic 
industrial security concept. With this in mind, our products undergo continuous development. 
We therefore recommend that you keep yourself informed with respect to our product updates. 
Please find further information and newsletters on this subject at:

http://support.automation.siemens.com (http://support.automation.siemens.com/WW/
llisapi.dll?aktprim=99&lang=en&referer=%2fWW
%2f&func=cslib.csinfo2&siteid=csius&extranet=standard&viewreg=WW&groupid=4000002)

To ensure the secure operation of a plant or machine it is also necessary to take suitable 
preventive action (e.g. cell protection concept) and to integrate the automation and drive 
components into a state-of-the-art holistic industrial security concept for the entire plant or 
machine. Any third-party products that may be in use must also be taken into account. Please 
find further information at:

http://www.siemens.com/industrialsecurity (http://www.industry.siemens.com/topics/global/
en/industrial-security/Pages/Default.aspx)

Network settings
The following tables show the network settings of each product you need to analyze the 
network security and to configure external firewalls:

STEP 7 Professional
Name Port number Transport 

protocol
Direction Function Description

ALM 4410* TCP Inbound/
outbound

License 
service

This service provides the complete 
functionality for software licenses and is 
used by both the Automation License 
Manager as well as all license-related 
software products.

RFC 1006 102 TCP Outbound S7 
communicatio
n

Communication to the S7 controller via 
Ethernet/PROFINET for programming and 
diagnostic purposes.

DCP --- Ethernet Outbound PROFINET The DCP protocol (Discovery and Basic 
Configuration Protocol) is used by 
PROFINET and provides the basic 
functionality for locating and configuring 
PROFINET devices.
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STEP 7 Professional
SNMP 161 UDP Outbound PROFINET The SNMP client functionality is used by 

STEP 7 to read status information from 
PROFINET devices.

* Default port that can be changed by user configuration

 

WinCC ES Basic (without simulation)
Name Port number Transport 

protocol
Direction Function Description

ALM 4410* TCP Inbound/
outbound

License 
service

This service provides the complete 
functionality for software licenses and is 
used by both the Automation License 
Manager as well as all license-related 
software products.

HMI Load 1033 TCP Outbound HMI Load (RT 
Basic)

This service is used to transmit images and 
configuration data to Basic Panels.

* Default port that can be changed by user configuration

 

Simulation RT Basic
Name Port number Transport 

protocol
Direction Function Description

HMI Load 1033 TCP Inbound HMI Load (RT 
Basic)

This service is used to transmit images and 
configuration data to Basic Panels.

Ethernet/
IP
 

44818 TCP Outbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

2222 UDP Inbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

Modbus 
TCP

502 TCP Outbound Modbus TCP 
channel

The Modbus TCP protocol is used for 
connections to Schneider PLCs.

RFC 1006 102 TCP Outbound S7 channel Communication to the S7 controller via 
Ethernet/PROFINET

Mitsubishi 
MC

5002 TCP Outbound Mitsubishi MC 
channel

The Mitsubishi protocol is used for 
connections to Mitsubishi PLCs.

2.2 Notes on use

Contents
Information that could not be included in the online help and important information about 
product characteristics.

STEP 7 Professional
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Online operation
The simultaneous online operation of STEP 7 V5.5 or earlier and STEP 7 Professional V12 
has not been approved.

Simultaneous online connections on an S7-1200 or S7-1500 CPU
It is not possible to establish an online connection from multiple TIA Portal instances 
simultaneously to the same S7-1200 or S7-1500 CPU.

Parallel use
If the term "Combo" appears in the name or license key of the software after installation, the 
use of the following products/versions is permitted in accordance with Article 1.6 of the General 
Terms and Conditions (see also setup text):

● STEP 7 Professional 2010

● STEP 7 Professional 2006

Configuring and assigning module parameters
You will find an overview of the modules that can be configured and assigned parameters with 
STEP 7 Professional V12 at http://support.automation.siemens.com (http://
support.automation.siemens.com/WW/view/en/28919804/133000).

Documentation on S7-PLCSIM
S7-PLCSIM is installed together with STEP 7 Professional. The documentation is saved 
centrally.

You can find the manuals under: C:\Programs\Siemens\Documentation\Product notes

You can find the readme files under: C:\Programs\Siemens\Documentation\Readme

Removing/inserting the memory card
After removing or inserting a memory card, always perform a memory reset on the CPU in 
order to restore the CPU to a functional condition.

Deleting data logs on the memory card with S7-1500 CPUs
If you delete data logs (csv files that were generated with data log applications) on the memory 
card via the web server of the CPU or via the file explorer on the PC, this could result in 
undefined behavior of the data log during further operation. The data logs might not be removed 
completely by the above-mentioned procedures.

Remedy: To delete data logs reliably, use the "DataLogDelete" instruction in the user program 
or format the memory card.

STEP 7 Professional
2.2 Notes on use
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Deleting a WinAC RTX from a SIMATIC PC
A controller application WinAC RTX with an assigned onboard CP interface in an interface slot 
(IF) cannot be deleted from a SIMATIC Box PC/Panel PC/Rack PC. If you wish to delete the 
WinAC RTX, you must first remove the onboard CP interface from the interface slot. To do 
this, the onboard CP interface must be selected in the network or device view and a different 
option (for example, "Windows only" or "SIMATIC PC station") must be activated in the 
inspector window under "CP assignment" instead of the option "SIMATIC WinAC". 

Removing and inserting Ethernet modules
If Ethernet modules are removed and re-inserted during operation, you must boot the PC; 
otherwise, the "Accessible devices" functionality in STEP 7 or NCM PC will not display all 
devices. While the PC boots, Ethernet modules must be activated.

Notes on the information system
The following functions have already been described in the information system, but are not 
available in STEP 7 Professional V12 SP1:

● Loading hardware configurations from the target system to the PG/PC.

Comparing project data
The comparison functions (online/offline, offline/offline) currently do not take hardware into 
consideration.

Loading project data with TIA Portal V11 and V12 (S7-1200)
If you load the project data of an S7-1200 CPU with the TIA Portal V12, you can no longer use 
TIA Portal V11 to access this data. To do this, first restore the factory settings of the CPU. 
Read the additional information on this in the online help under "How to reset a CPU to factory 
settings".

Activating ENO enable output
As of STEP 7 TIA Portal V12.0, the ENO enable output is disabled by default in the 
programming languages LAD and FBD and the ENO parameter is shown grayed out. If needed, 
you can activate the enable output and thereby specifically control the instructions for which 
you want to have error evaluation.

To activate the ENO enable output of an instruction, follow these steps:

1. In your program, right-click the instruction for which you want to activate the ENO enable 
output.

2. Select the "Generate ENO" command from the shortcut menu.
The ENO value is generated for the instruction and the color of the ENO parameter changes 
from gray to black.
Additional instructions are inserted with the enable output.

STEP 7 Professional
2.2 Notes on use
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Compatibility
The device configuration and program of an S7-1200 CPU must always be configured with the 
same STEP 7 version. Usually, the TIA Portal makes sure that no version conflicts occur by 
outputting appropriate notifications during loading to the device.

This automatic verification is not possible with S7-1200 CPUs with firmware version V1.x. In 
this case, users themselves must ensure that no version conflicts occur.

2.3 Editing devices and networks

2.3.1 General information on devices and networks

Contents 
Currently, there is no general information available on devices and networks.

2.3.2 Use of modules on the S7-1200

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Use of modules on the S7-1200
The modules listed below are not supported on the S7-1200.

Family Module Order number
S7-300 FMs SM 338 6ES7 338-4BC01-0AB0

FM 350-1 6ES7 350-1AH03-0AE0
FM 350-2 6ES7 350-2AH00-0AE0, 6ES7 350-2AH01-0AE0
FM 351 6ES7 351-1AH01-0AE0, 6ES7 351-1AH02-0AE0
FM 352 6ES7 352-1AH02-0AE0
FM 355 S 6ES7 355-1VH10-0AE0
FM 355 C 6ES7 355-0VH10-0AE0
FM 355-2 C 6ES7 355-2CH00-0AE0
FM 355-2 S 6ES7 355-2SH00-0AE0

S7-300 PtP-CP CP 340 6ES7 340-1AH02-0AE0, 6ES7 340-1BH02-0AE0, 6ES7 
340-1CH02-0AE0

STEP 7 Professional
2.3 Editing devices and networks
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Family Module Order number
CP 341 6ES7 341-1AH01-0AE0, 6ES7 341-1AH02-0AE0, 6ES7 

341-1BH01-0AE0, 6ES7 341-1BH02-0AE0, 6ES7 
341-1CH01-0AE0, 6ES7 341-1CH02-0AE0

Network component Diagnostics repeater 6ES7 972-0AB01-0XA0
ET 200S 1 Count 24 V 6ES7 138-4DA04-0AB0

1 Count 5 V 6ES7 138-4DE02-0AB0
1 Step 5 V 6ES7 138-4DC00-0AB0, 6ES7 138-4DC01-0AB0
2 pulses 6ES7 138-4DD00-0AB0, 6ES7 138-4DD01-0AB0
1 SI 6ES7 138-4DF01-0AB0
1 SI Modbus 6ES7 138-4DF11-0AB0
1 SSI 6ES7 138-4DB02-0AB0, 6ES7 138-4DB03-0AB0
1 Pos Universal 6ES7 138-4DL00-0AB0
SIWAREX 7MH4910-0AA01, 7MH4912-0AA01, 7MH4920-0AA01

ET 200M SIWAREX 7MH4 900-2AA01, 7MH4 900-3AA01, 7MH4 950-1AA01, 
7MH4 950-2AA01

2.3.3 Replacing ET 200S positioning modules

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Replacing ET 200S positioning modules
This information relates to the positioning module "1 Step 5V" (6ES7 138-4DC00-0AB0) from 
a project which was created with TIA Portal V11.0. When replacing these modules from the 
TIA Portal V11.0 with a new version of these modules, the parameter settings are reset to the 
default values.

This is the case with one of the following procedures:

● Replace the positioning module 6ES7 138-4DC00-0AB0 with its successor module 6ES7 
138-4DC01-0AB0 by means of a device exchange.

● Updating the module version using the appropriate button in the device properties in the 
Inspector window.

2.3.4 CP 343-2 on SIMATIC S7 Embedded Controller EC31-RTX

Contents
Information that could not be included in the online help and important information about 
product characteristics.
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CP 343-2 on SIMATIC S7 Embedded Controller EC31-RTX
The module AS-Interface CP 343-2 (order no.: 6GK7 343-2AH01) can be inserted in an 
expansion rack of the SIMATIC S7 Embedded Controller EC31-RTX (order no.: 6ES7 
677-1DDxx-0BB0), but the CP 343-2 cannot be operated with the EC31-RTX.

2.3.5 Notes on online and diagnostics

Contents 
Information that could not be included in the online help and important information about 
product characteristics.

Hardware detection followed by online connection
When the "Online > Hardware detection" command is performed for an unspecified CPU, the 
online configuration is not loaded from the CPU. If you do not load the configuration resulting 
from the hardware detection to the CPU, the device and network views will always show a 
difference between the offline and online configurations. It will appear that there are different 
configurations in the online and diagnostic views, although the MLFBs are identical in the actual 
CPU and the offline CPU.

2.3.6 Network components

2.3.6.1 Network components

Security modules

Migration of projects with Ethernet CPs and activated Security
STEP 7 V5.5 projects that contain Industrial Ethernet CPs with activated Security are migrated 
to STEP 7 V12 or higher without security settings.

If necessary, follow these steps after the migration:

1. Activate the security functionality. 

2. Configure the required security settings.

Use of symbolic names when configuring security functions
The use of symbolic names during the configuration of Security functions is not supported.
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Migration of IP access protection lists when activating the security functions
An active IP access protection list is converted to firewall rules when security functions are 
activated. These rules are visible in advanced firewall mode and can be adjusted there. The 
advanced firewall mode is activated automatically.

Security online diagnostics of S7 CPs
Security online diagnostics of a CP with security capability is only possible if the online 
connection was established directly via the CP. If the online connection from STEP 7 V12 to 
the station was established via the CPU, no security online diagnostics of the CP is possible.

To establish an online connection directly via the CP, you need to enter the IP address of the 
CP in the "Station address" input box under the entry "Online access" in online diagnostics. 
Only then is security online diagnostics of the CP possible.

This relates to the CPs with security capability for the SIMATIC S7-300/400/1500.

Setting up numerous VPN groups 
After setting up 40 VPN groups in a project you need to save this project. Only then is it possible 
to set up additional VPN groups. Then, restart STEP 7 V12 and reopen the project. Only then 
is it possible to set up additional VPN groups.

IKE mode
When negotiating the key in phase 1 the IKE mode "Main" should be preferred. This mode 
normally provides a reliable procedure compared with the "Aggressive" mode. One reason for 
using the "Aggressive" setting is when you have VPN groups with different pre-shared keys 
since only one pre-shared key is supported with the "Main" setting.

The IKE "Aggressive" mode should not be used in conjunction with certificates. In the IKE 
"Aggressive" mode, only use pre-shared keys.

The SOFTNET Security Client only supports the IKE "Main" mode.

A security module must not be used in VPN groups that use different IKE modes.
 

Copying the CP 1242-7 into another project
If you copy a CP 1242-7 from one project into another project, the following parameters in the 
parameter group "CP identification" are changed on the target station:

● Project number of the CP

● Station number of the CP
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Download to device
Only use the "Download to device" function with the CP 1242‑7 via a TeleService connection 
as follows:

1. Select the CP in STEP 7.

2. Select the "Online" > "Download to device" menu.

3. In the "Extended download" dialog that appears, select the TeleService interface.

4. Download the project data from the "Extended download" dialog.

Upload from device
The function "Upload from device" is not supported by the CP 1242‑7.

program blocks S7-1500

FTP_CMD for FTP services
When setting parameters in the job blocks for the FTP_CMD command, note the following 
difference compared with the description in the Info system.

In the UDT data types FTP_FILENAME and FTP_FILENAME_PART, the "LenFilename" 
parameter is not evaluated is therefore of no significance.

Reason:

The "Filename" parameter for specifying the file name already includes length information in 
the STRING data type used. Only this length information is evaluated when the command is 
processed.

Using PC CPs

Firmware download for S7-300/400 PROFIBUS CPs via CP 5612 or CP 5622
If the required interface parameter assignment "FWL" or "FWL_FAST_LOAD" is not available 
for the firmware download, follow these steps:

1. Open the "Set PG/PC interface" program. You can find the program in the Control Panel 
of your Windows operating system.

2. Copy the interface parameter assignment depending on the operating system:

– For 32-bit operating systems:
"CP5612(PROFIBUS)" / "CP5622(PROFIBUS)"

– For 64-bit operating systems:
"CP5612.PROFIBUS.1" / "CP5622.PROFIBUS.1"
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3. Depending on your requirements, give the copy one of the following names: 

– For 32-bit operating systems:
CP5612(FWL) / CP5622(FWL)
CP5612(FWL_FAST_LOAD) / CP5622(FWL_FAST_LOAD) 

– For 64-bit operating systems:
"CP5612.FWL.1" / "CP5622.FWL.1"
"CP5612.FWL_FAST_LOAD.1" / "CP5622.FWL_FAST_LOAD.1"

4. Open the properties of the entry and make the following settings in the "PROFIBUS" tab:

– Select the check box for "PG/PC is the only master on the bus".

– Assign the value "0" to the address.

– Set the value 187.5 Kbps (or the value 1.5 Mbps for FWL_FAST_LOAD) as the 
transmission speed.

– Change the "Highest device address" to the value 126.

– Change the profile to "Universal (DP/FMS)".

5. Exit the "Set PG/PC interface" program.

Result:

The selected interface parameter assignment is now available in the firmware loader.

SIMATIC NET PC software for PC communications processors
The use of the SIMATIC NET PC software versions listed below is recommended for the 
following communications processors depending on the operating system:

● CP 1613, CP 1613 A2, CP 1623, CP 1628

● CP 5613, CP 5613 A2, CP 5614, CP 5614 A2, CP 5623, CP 5624

You should use the following versions of the SIMATIC NET PC depending on the operating 
systems:

● Windows 7 (Professional, Enterprise, Ultimate), 32- and 64-bit and Windows Server 2008 
R2
"SIMATIC NET PC Software" DVD V8.2

● Windows XP, Windows Server 2003 and Windows Server 2008, 32-bit
"SIMATIC NET, PC Software, Edition 2008 + SP4" CD, version number V7.1.4

Operating PROFIBUS CPs in computers with STEP 7 V5.5
If both STEP 7 V5.5 and STEP 7 V12 are installed on a computer and STEP 7 V5.5 is removed, 
the setup repair function of STEP 7 V12 must be run before the following communications 
processors can be used as network adapters for downloading firmware:

● CP 561x, CP 5611 A2, CP 5612, CP 5613 A2, CP 5614 A2

● CP 5621, CP 5622, CP 5623, CP 5624

● CP 5711
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See also
Service & Support (http://support.automation.siemens.com/WW/view/en/12660737)

IO routing with CP 1616 / CP 1604

CP as PROFINET IO router - what this means in practice
You can operate a PC station with the communications modules CP 1616 / CP 1604 as a 
PROFINET IO router by using the relevant CP as a PROFINET IO device and PROFINET IO 
controller at the same time. This IO routing allows process data to be exchanged between two 
PROFINET IO systems. If the configuration is set up correctly the CP can, for example, allow 
certain process level inputs and/or outputs to be accessed at control level.

In a typical configuration the CP then simultaneously satisfies the following functions:

● PROFINET IO Device for a higher-level PROFINET IO controller of the control level

● PROFINET IO controller with connected IO devices for the subordinate process level

Assign configuration - transfer area "TM" (transfer module mapping)
In the configuration, select the "IO device" option under "Operating mode" .

The additional "I-device communication" configuration area appears, in which you can make 
the settings for the IO routing. There you specify the type and the size of the transfer area for 
IO routing to the higher-level IO controller under "Transfer area detail".

The following options are available for the "Transfer area type":

● CD: Controller Device
Select this option to specify a transfer area between the IO controller and IO device. Refer 
to additional information on this in the online help under "Configuration for PROFINET IO".

● TM: Transfer module mapping
Select this option for the IO router application. An additional configuration area with the 
name specified appears in the Inspector window under "Operating mode / I-device 
communication". In this configuration area make the assignment for the transfer module 
mapping in the mapping table.

Transfer module mapping
Transfer modules represent the data areas routed from the lower-level IO system into the 
higher-level IO system.

Enter the IO devices from the lower-level IO system in the mapping table in accordance with 
your requirements..

The table contains the following columns:
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Parameter Meaning
Offset Offset relative to the 1st bit in the transfer module

The specification has the form <Byte>.<Bit>.
Example: 0.5

Device/module (slot) Specification of the IO device
The displayed dialog shows the IO devices configured on the 
IO system.

IO type Select the IO type via the drop-down list box.
The selection options depend on the transfer module type.

Start Start address (offset) in the data area of the IO device
The specification has the form <Byte>.<Bit>.
Example: 0.0

End End address (offset) in the data area of the IO device
The specification has the form <Byte>.<Bit>.
Example: 8.0

Pulling and plugging Ethernet modules

Pulling and plugging Ethernet modules
Ethernet modules, for example USB network cards, must already be plugged and activated 
when the system starts. If Ethernet modules are deactivated or do not exist when the system 
starts or they are pulled and plugged again during operation, the "Available devices" 
functionality does not display all the nodes in STEP 7. This also applies to the change of 
docking stations when the Ethernet module is not plugged in the notebook but rather in the 
docking stations.

Activate the deactivated Ethernet modules by using "Control Panel > Network Connection" 
and reboot the system. Also reboot the system if Ethernet modules were plugged during 
operation or if the docking station with the Ethernet module was changed during operation.

CPU messages for OPC server

SIMATIC NET OPC server - Recommendations on the configuration of CPU messages
If you configure CPU messages for a SIMATIC NET OPC server of a PC station, their 
consistent configuration will not be verified by STEP 7. To ensure error-free functioning of the 
messages, note the following recommendations:

● Only ever configure one S7 connection with alarm capability per CPU for receiving 
messages.

● Only use one language for message texts in a given project. The use of multi-language 
message texts is not supported.

● For all messages, avoid inputting user-specific sources (additional text 1). The uniqueness 
of the messages is automatically ensured if the default sources are used.
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SCALANCE X

SCALANCE XR500 as IO device: "Compile" and "Download to device"
With a SCALANCE XR500 configured as a PROFINET IO device and assigned to an IO 
controller, the functions "Compile" and "Download to device" only download the data to the 
switch that can also be configured in Web Based Management (WBM) (layer 2, layer 3, system, 
security).

If you want to use the "Compile" or "Download to device" functions for the PROFINET IO device 
data of the XR500, first select the assigned IO controller.

Using a link aggregation in an MSTP instance
If you want to use a link aggregation in an MSTP instance, follow the steps below during 
configuration:

1. Create a link aggregation in "Layer 2" > "Link Aggregation".

2. Create an MSTP instance in in "Layer 2" > "MSTP" > "MST General".

3. Configure the link aggregation in "Layer 2" > "MSTP" > "MST Port".

Automatic activation of MRP in redundant topologies
If you connect SCALANCE X switches with redundant network structures in the topology view, 
MRP is activated automatically on the switches involved.

If there is an existing configuration with other redundancy mechanisms, such as MSTP, this 
is automatically deactivated.

2.4 Programming a PLC

2.4.1 General notes on PLC programming

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Use of the I/O access error OB with an S7-1500 CPU
If you are using the I/O access error OB with an S7-1500 CPU and the check box "Optimized 
block access" under "Properties > Attributes" is selected (default setting), the following applies 
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to the "Area" tag of the start information: "Area" is the ID for the area in which the incorrect 
access occurred and can have the following values: 

● B#16#01: Direct access to input

● B#16#02: Direct access to output

● B#16#81: Access to process image input

● B#16#82: Access to process image output

Loading inconsistent programs to an S7-1500 CPU
In TIA Portal, it is not possible to download inconsistent programs to an S7-1500 CPU without 
a consistency check. During the loading process, all blocks of the program are implicitly 
checked and are compiled again in the event of inconsistencies. If, however, there are 
programs on your CPU which were loaded with earlier versions of STEP 7, these programs 
could demonstrate inconsistencies. 

In this case, note the following:

If you load an inconsistent program from a device, you will not be able to load the program 
back to an S7-1500 CPU unchanged afterwards, because a consistency check always takes 
place during the loading process and existing inconsistencies are corrected.

Loading data blocks from a device
Please note that the two CPU families handle the values of tags differently when downloading 
blocks from a device.

● S7-1200/1500
CPUs of the S7-1200 series store the start values with which a data block is loaded to the 
CPU in the load memory. If you load a data block from an S7-1200 CPU, these start values 
are applied from the load memory to the offline data block again. Even if you have made 
value changes in the load memory during runtime by means of the "WRIT_DBL" instruction, 
the values originally loaded to the device are applied to the offline data block.
In order to apply the current monitored values from the CPU, you can use the function 
"Snapshot of the monitored values". You can find detailed information on this in the 
information system, in the section "Programming data blocks". 

● S7-300/400
CPUs of the series S7-300/400 also store the start values with which a data block is loaded 
to the CPU in the load memory. However, they cannot read the values back from the load 
memory. If you load a data block from a device, the current monitored values are loaded 
from the CPU and entered in the "Start values" column in the offline data block. 

Importing organization blocks from external STL/SCL sources
CPUs of the S7-300/400 series accept organization blocks with any name during import. If you 
import an OB with a standard name (for example, CYCL_EXC or CYC_INT5), it is automatically 
assigned to the correct OB class. If you import an OB with an unknown name, an OB0 is 
created. You can change this number after the import and hereby assign it to the desired OB 
class. To change to the OB number, select "Properties" in the shortcut menu.
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When importing from external sources to a CPU of the series S7-1200/1500, only organization 
blocks with standard names are accepted. An OB with an unknown name is invalid after the 
import and is identified with a no parking character. You should, therefore, use a text editor to 
change the name of the organization block in the title bar of the external source before the 
import into the TIA Portal.

Process image of PTO/PWM outputs
Do not use PTO/PWM outputs in the process image (for example, for access in the user 
program, for online functions or in HMI). The update rate of the process image is much slower 
than the rate of the signal changes. The display in the process image therefore does not reflect 
the signal flow.

Moving system blocks
Moving objects from the "System blocks" folder to the "Program blocks" folder is not permitted.

Monitoring blocks in LAD and FBD
If the start of the current path is outside the visible range, it may not be possible to determine 
the input value. In this case, the current path is shown grayed out.

Indexed access to array elements and run tag in SCL
For CPUs of the S7-300/400 series, you can only use values of the INT data type as ARRAY 
limits or run tags. The use of other data types leads to a compilation error.

Resetting registration requirements for GRAPH blocks
When errors and faults are reset via the "REG_EF" input parameter, the following differences 
exist between the CPU families with respect to resetting the registration requirement:

● S7-300/400
The registration requirement is retained until an interlock or supervision error occurs in a 
step. Only then is the "R1" event triggered, the associated action executed, and the 
registration requirement reset.

● S7-1500
The registration requirement is always reset, whether or not interlock or supervision errors 
occur in the current cycle.

Avoid using PLC data types generated by the system in libraries
Some instructions generate their own PLC data types during instancing which are saved in 
the "PLC data types" project folder. However, you should not use these system-generated 
PLC data types in any library, because they may be recreated by the system at any time and 
may result in an unfavorable system behavior.
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Note on data consistency in S7 communication and Open User Communication
In the S7-1500 module series, you can change parameters during ongoing operation with the 
instructions of S7 communication as well as with Open User Communication. Changed 
parameters are used immediately, even if a job is still active. Both can lead to data 
inconsistency! To avoid data inconsistencies, you should never change parameters while a 
job is running.

Using global data blocks in assignments
It is not possible to assign the contents of a global data block to a structurally identical data 
block, e.g. using a move box.

Conversion of know-how protected blocks from V10.5
The program must be compiled after conversion from previous STEP 7 versions (e.g., STEP 
7 V10.5). If you are using know-how protected blocks, you are prompted to enter the password.

2.4.2 Instructions

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Use of instructions (S7-1500)
If a parameter-specific error occurs with instructions which represent a system function (SFC) 
or system function block (SFB), no error code is output at parameter RET_VAL. RET_VAL is 
invalid in this case. You have a number of different options for responding to these errors, 
depending on the CPU used.

Instruction "PE_CMD: Start and exit energy-saving mode / Read out status information" and 
"PE_START_END: Start and exit energy-saving mode" (S7-1500)

Addressing a PROFINET IO device

For the two instructions at the ID parameter, use the hardware ID of the head module of the 
IO device. Refer to the system constants of the assigned IO controller for the hardware ID. 
The name of the head module is composed of the name of the IO device and the suffix [Head] 
(example: "IO_Device_1[Head]").

Instruction "TRCV_C: Receive data via Ethernet" (S7-1500) 
Contrary to the information provided in the online help, the communication connection is 
terminated immediately, and not after sending data, when the CONT parameter is set to the 
value "0".
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Instruction "SET_TIMEZONE: Set time zone" (S7-1500) 
Contrary to the information provided in the online help, the "Set time zone" instruction is not 
available in TIA Portal V12 SP1 on CPUs of the S7-1500 series.

Instruction "T_CONFIG: Configure interface" (S7-1500) 
The CPU is restarted after you have executed the "Configure interface" instruction in order to 
change an IP parameter. The CPU goes to STOP mode, a warm restart is carried out and the 
CPU starts up again (RUN mode). Make sure that the control process is in a secure operating 
mode after the CPU has been restarted following execution of the "Configure interface" 
instruction. Uncontrolled operation can result in serious material damage or personal injury 
due to malfunctions or programming errors, for example. Non-retentive data could be lost.

Parameters ERROR and STATUS

ERROR STATUS
(DW#16#..)

ERR_LOC Explanation

0 00000000 0 After the instruction has been 
executed successfully, the 
STATUS parameter 
"00000000" does not return 
any value.

Instruction "MOVE_BLK_VARIANT: Move block"
The DEST_INDEX parameter is calculated zero-based. If an Array is specified at parameter 
DEST, the integer at the DEST_INDEX parameter specifies the first element within the target 
area to which copying is to take place. This is independent of the declared Array limits.

The SRC_INDEX parameter is calculated zero-based. If an Array is specified at parameter 
SRC, the integer at the SRC_INDEX parameter specifies the first element within the source 
area from which copying is to take place. This is independent of the declared Array limits.

Instruction "IO2MOD: Determine the hardware identifier from an IO address" (S7-1500)
If you wish to use the instruction "IO2MOD: Determine the hardware identifier from an IO 
address" in SCL to determine the hardware ID of a module from an I/O output address, you 
cannot program this using the I/O access ID "%QWx:P". In this case, use the symbolic tag 
name or the absolute address of the output in the process image.

Instruction "GET_DIAG: Read diagnostics information"
MODE 3 at the MODE parameter is not supported by the S7-1200 CPU.

Instruction "GET_IM_DATA: Read the identification and maintenance data" (S7-1500)
The "IM0_DATA" structure is not available as a system structure for reading out I&M0 data in 
TIA Portal V12 SP1. Instead, you can use the data structure "ARRAY of BYTE" to store the 
data.
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Error code 0x807F at parameter RET_VAL

The S7-1500 CPUs can execute a maximum of 10 instances of the "Read the identification 
and maintenance data" instruction in parallel. Once this number has been exceeded, the output 
parameter RET_VAL assumes the value 0x807F and the instruction is not executed.

Remedy:

● Avoid more than 10 parallel calls of the instruction.

● Repeat the call at a later time, as this is a temporary error.

Instruction "BLKMOV: Move block"
The explanation of the error code at parameter RET_VAL has changed:

Error code (W#16#...) Explanation
8092 The source or target area is only available in the load memory.

Instruction "Gen_UsrMsg: Generate user diagnostic alarms" (S7-1500)
The "Gen_UsrMsg" instruction described in the help is not available in V12 SP1.

Using instructions with parameters of type VARIANT in code blocks with different access types 
(S7-1500)

Code blocks (FBs/FCs) and data blocks (DBs) can be created with different access types 
("standard" and "optimized"). In code blocks, you can call any instructions. Certain instructions 
(for example, "WRIT_DBL" and "READ_DBL") use pointers of type VARIANT at input and 
output parameters to address data blocks.

Ensure that you do not use these instructions in programs in which code blocks of different 
access types are called reciprocally. This could cause the following to occur:

● A structure from a standard data block is directly or indirectly passed to an optimized code 
block, which forwards this structure directly or indirectly to one of the blocks mentioned 
above.

● The reverse scenario, whereby a structure from an optimized code block is directly or 
indirectly passed to a standard data block, which forwards this structure directly or indirectly 
to one of the blocks mentioned above.

Output parameters of the S7-1500 instructions
If an access error or a programming error occurs while the instruction is being executed, the 
value of the output is undefined.
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2.4.3 Testing the user program

2.4.3.1 Testing with the watch table

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Multiple access to the same CPU
Access to a CPU from a PG/PC is permitted only when a TIA Portal is open. Multiple access 
to the same CPU is not permitted and can lead to errors.

Loading data blocks during an active control job
 

 Note

Loading changed data blocks during an active control job can result in unforeseen operating 
states. The control job continues to control the specified address, although the address 
allocation may have changed in the data block. Complete active control jobs before loading 
data blocks.

 

Testing programs converted from STEP 7 V10.5.
To monitor and test a program converted from STEP 7 V10.5, you have to first compile and 
load with STEP 7 V11.0.

"Enable peripheral outputs" function
In TIA Portal V12.0, the function "Enable peripheral outputs" is not available for CPUs from 
the S7-1500 series.
This function can only be carried out with an S7-300, S7-400 or S7-1200 CPU in TIA Portal 
V12.0. 

2.4.3.2 Testing with the force table

Contents
Information that could not be included in the online help and important information about 
product characteristics.
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Forcing tags for direct I/O access
If you use direct I/O access for an S7-300 CPU in your user program, forcing this I/O address 
is not permitted.

Example
If I/O access to the address "IB0:P" takes place in the user program, it is not permitted to force 
the following I/O address areas: I0.0:P, IB0:P, IW0:P and ID0:P.

2.5 Technological functions

2.5.1 Notes on technological functions

S7-1500 technology modules
Contrary to the information provided in the online help, the commissioning editor for the 
S7-1500 technology modules is not yet available.

S7-1500 Motion Control - axis control panel and tuning
The parameter values modified with the axis control panel or by tuning are discarded after the 
return of control priority. If necessary, transfer the values to your configuration.

When control priority is taken over, the configuration of the technology object is applied. 
Changes to the configuration of the technology object do not take effect until the control priority 
is returned. For this reason, make any necessary changes before control priority is taken over.

S7-1500 Motion Control - axis control panel
"Forward" and "Backward" buttons: 

Click the "Forward" or "Backward" button to initiate a movement in the positive or negative 
direction in accordance with the selected mode.

"Absolute positioning" mode:

If you have activated the "Modulo" setting of the technology object, the "Forward" and 
"Backward" buttons are shown in the "Controller" area. You can leave the valid Modulo area 
with these buttons. 
If you have not activated the "Modulo" setting of the technology object, only the "Start" button 
is shown in the "Controller" area. You can approach the specified position directly.

Failure of the online connection to the CPU

If the online connection to the CPU fails during operation with the axis control panel, the axis 
is stopped with maximum delay after expiration of the sign-of-life monitoring. The master 
control is returned to the user program in this case.
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If the master control of the axis control panel is lost repeatedly without a direct error message, 
the online connection to the CPU could be affected by a communication load that is too high. 
In this case, the alarm display archive displays the alarm "Error occurred during 
commissioning. Sign-of-life failure between controller and TIA Portal". 

To remedy this error, adjust the sign-of-life monitoring in the tag of the 
<TO>.ControlPanel.Input.TimeOut technology object. The preset value of the tag is 2000 ms. 
You can change the value of the tag directly. The change becomes effective the next time you 
fetch the master control.

S7-1500 Motion Control - tuning
"Forward" and "Backward" buttons:

Click the "Forward" or "Backward" button to start a test step for tuning in the positive or negative 
direction.

"Measurement duration"

If you enter an invalid value in the "Measurement duration" field, a warning dialog appears. 
You must confirm this dialog with "OK" within 2 seconds. If you do not confirm the dialog within 
2 seconds, master control is returned to the user program.

S7-1500 Motion Control - Motion Control instruction MC_Home
The values preset under "Technology object > Configuration > Extended parameters > 
Dynamic default values" are used for the dynamic values Acceleration, Deceleration and Jerk.

S7-1500 Motion Control - Change of MC-Servo cycle clocks
Changes to the MC-Servo cycle clocks are not permitted to be loaded to the controller in RUN 
mode of the CPU.
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S7-1500 Motion Control - Effectiveness of changes in the technology data block
In the case of value changes which are effective immediately, we distinguish between the 
following data types:

● LREAL data type
(e.g. <TO>.Override.Velocity)
Value changes take effect immediately when these tags are written. The technology object 
carries out a range check of the written value and works immediately with the new value. 
If range limits are violated during writing, the technology object automatically corrects the 
values. If the range is undershot, the value is set to the low range limit; if the range is 
overshot, the value is set to the high range limit. You write changes via direct assignments. 
The changes are retained until the next POWER OFF of the CPU or restart of the technology 
object.

● DINT/BOOL data types
(e.g. <TO>.Sensor[n].ActiveHoming.Direction)
Changes are only permitted in the defined value range. Value changes outside the value 
range are not applied. If you write invalid values, the programming error OB (OB 121) is 
started. You write changes via direct assignments. The changes are retained until the next 
POWER OFF of the CPU or restart of the technology object.

S7-1500 Motion Control - Configuration of a positioning axis via an HMI device
If a tag exists both at the speed axis and at the positioning axis (e.g. <TO>.Velocity), you 
cannot access the tag of the positioning axis via an HMI device.

Copy the tag of the positioning axis via your user program into a data block which you have 
created. You can access the copy of the tag via an HMI device. 

S7-1500 Motion Control – Status of the approached hardware limit switch
The position of the axis on detection of the hardware limit switch is saved internally in the CPU. 
The status of the approached hardware limit switch is not reset until the hardware limit switch 
is exited and the axis has returned to the maximum traversing range.

To retract the axis after approaching the hardware limit switch and to reset the status of the 
hardware limit switch, follow these steps:

1. Acknowledge the technology alarm to enable movements in the direction of retraction.

2. Move the axis in the direction of retraction until it exits the hardware limit switch.
The axis must then be located in the maximum traversing range.
If you travel in the opposite direction to the direction of retraction before you exit the 
hardware limit switch, monitoring is triggered once again.

The diagram below shows the behavior of the status word when you approach the hardware 
limit switch and when you retract the axis: 
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The position of the axis on detection of the positive hardware limit switch is saved internally in 
the CPU at the time ①. This position must be undershot to reset the status of the hardware 
limit switch.

The position of the axis on detection of the negative hardware limit switch is saved internally 
in the CPU at the time ②. This position must be exceeded to reset the status of the hardware 
limit switch.

S7-1500 Motion Control - Technology alarms

No
.

Response Error bit Warning 
bit

Alarm text

41
2

Remove enable SensorFa
ult

- Violation of the high range limit of the incremental process value

S7-1500 Motion Control - FAQs with remedies for technology alarms
You can find the FAQs with remedies for technology alarms on the Internet (http://
support.automation.siemens.com/WW/view/en/66958052).

S7-1500 Motion Control - Error ID

ErrorID Description Remedy
16#8015 Error acknowledgment with "MC_Reset" not possible. 

Error during configuration of the technology object.
Check the configuration of the technology object.
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2.5.2 Notes on technological functions
There are no notes about the technology functions.

2.5.3 Notes on technological functions

Parameter assignment for the FM x51 and FM x52
In contrast to the information in the Online Help, if you change the measuring system, the 
previously entered parameter values are not converted to the new measuring system.

Programming FM x50-1, FM x51 and FM x52
The "initial values" specified in the parameter tables in the online help regarding the instructions 
correspond to the "default value" in the software interface of the user programming.

IM 174 migration
During the migration of projects with IM 174, the parameter assignment of IM 174 is set to 
default values. It is absolutely necessary to set parameters for IM 174 again after the migration.

2.5.4 SIMATIC STEP 7 Easy Motion Control

2.5.4.1 Notes on SIMATIC STEP 7 Easy Motion Control
There are no notes available on SIMATIC STEP 7 Easy Motion Control.

2.5.5 SIMATIC STEP 7 PID Professional

2.5.5.1 Notes on SIMATIC STEP 7 PID Professional
There are no notes available on SIMATIC STEP 7 PID Professional.
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WinCC Basic 3
3.1 Security information

Security information
Siemens provides automation and drive products with industrial security functions that support 
the secure operation of plants or machines. They are an important component in a holistic 
industrial security concept. With this in mind, our products undergo continuous development. 
We therefore recommend that you keep yourself informed with respect to our product updates. 
Please find further information and newsletters on this subject at:

http://support.automation.siemens.com (http://support.automation.siemens.com)

To ensure the secure operation of a plant or machine it is also necessary to take suitable 
preventive action (e.g. cell protection concept) and to integrate the automation and drive 
components into a state-of-the-art holistic industrial security concept for the entire plant or 
machine. Any third-party products that may be in use must also be taken into account. Please 
find further information at:

http://www.siemens.com/industrialsecurity (http://support.automation.siemens.com) 

Passwords
Various passwords are set by default in WinCC. For security reasons, you should change 
these passwords.

● For the user "Administrator", the default password is "administrator".

Communication via Ethernet
In Ethernet-based communication, end users themselves are responsible for the security of 
their data network. The proper functioning of the device cannot be guaranteed in all 
circumstances; targeted attacks, for example, can lead to overload of the device.

Ending Runtime automatically
If automatic transfer is enabled on the HMI device and a transfer is started on the configuration 
PC, the running project is automatically stopped. 

The HMI device then switches autonomously to "Transfer" mode.

After the commissioning phase, disable the automatic transfer function to prevent the HMI 
device from switching inadvertently to transfer mode.

Transfer mode can cause undesired reactions in the system.

To block access to the transfer settings and thus avoid unauthorized changes, assign a 
password in the Control Panel.
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Network settings
The following tables show the network settings of each product which you need in order to 
analyze the network security and for the configuration of external firewalls:

WinCC Basic (without simulation)
Name Port 

number
Transport 
protocol

Direction Function Description

ALM 4410* TCP Inbound, 
Outbound

License service This service provides the complete 
functionality for software licenses and is used 
by both the Automation License Manager as 
well as all license-related software products.

HMI Load 1033 TCP Outbound HMI Load 
(RT Basic)

This service is used to transmit images and 
configuration data to Basic Panels.

* Default port that can be changed by user configuration

 

WinCC Simulation for Basic Panels
Name Port 

number
Transport 
protocol

Direction Function Description

HMI Load 1033 TCP Inbound HMI Load 
(RT Basic)

This service is used to transmit images and 
configuration data to Basic Panels.

EtherNet/IP 44818 TCP Outbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

2222 UDP Inbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

Modbus TCP 502 TCP Outbound Modbus TCP 
channel

The Modbus TCP protocol is used for 
connections to Schneider PLCs.

RFC 1006 102 TCP Outbound S7 channel Communication with the S7 controller via 
Ethernet/PROFINET

Mitsubishi MC 5002 TCP Outbound Mitsubishi MC 
channel

The Mitsubishi protocol is used for connections 
to Mitsubishi PLCs.

See also
http://www.siemens.com/industrialsecurity (http://www.industry.siemens.com/topics/global/
en/industrial-security/Pages/Default.aspx)

3.2 Notes on use

Contents
Information that could not be included in the online help and important information about 
product characteristics.
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Copying HMI devices with HMI connections
If you copy an HMI device with HMI connections to a PLC, the HMI connection in the new HMI 
device is not automatically connected to an existing PLC with the same name. This applies to 
copying within a project as well as copying across projects.     

To access the PLC tag via HMI tag in the new HMI device, you have to complete the HMI 
configuration immediately after copying. Proceed as follows:

1. Open the "Devices & Networks" editor.

2. Connect the new HMI device to the desired network.

3. Open the connection table.

4. Select the HMI connection of the new HMI device.

5. Select the desired PLC under "Partner".

If you compile the new HMI device or connect additional PLC tags in between copying the HMI 
device and completing the connection, there may be some instances in which an additional 
HMI connection to the same PLC is created. This is especially true if you connect HMI tags 
with DB array elements.

Device replacement
After an HMI device has been replaced, you should check the appearance of the configured 
screens. Changing the size of the display may result in changes to the position and appearance 
of screen objects, e.g. recipe view and alarm view.

Device replacement - communication
If an HMI device is replaced, error messages of the type "... is not supported in the new 
configuration and will therefore be removed" may be generated. These alarms refer to 
configured connections of the device and are triggered, for example, if the HMI devices have 
a different number of interfaces. These connections are marked red after a device replacement. 
If you would like to continue to use these connections, you have change the configuration of 
the connection. Proceed as follows:   

1. Open the "Devices and Networks" editor.

2. Click "Network" in the toolbar of the network view.

3. Network the interface of the HMI device with the interface of the CPU.

4. Click in the table area of the network view on the "Connections" table.

5. Select the connection marked red.

6. Enter the new interface under "Properties > General > Interface" in the Inspector window.

Specifying the time of modification in the overview window
The times of modification displayed in the overview window only refer to changes to the object 
itself. Changes to subordinate objects, e.g. screen objects in a screen, do not cause the time 
of the last change to the screen to change in the overview window.   
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HMI device wizard
When you create a device with a color display using the HMI device wizard, the graphics of 
the navigation buttons may be displayed in black and white. This error only occurs, however, 
if the new device is created with the same name as a device with a monochrome display which 
has been deleted in the meantime.

You can avoid this error by always deleting the associated graphics in the Graphics collection 
whenever you delete a device from the project.

Objects with object references in the project library
Two copying methods can be used in WinCC flexible.   

● With "simple copy" a WinCC flexible screen including an IO field, for example is copied. 
Only the object name of a tag configured on the IO field is copied, as this is a reference.

● With "copy", a screen, an IO field contained there and a tag configured on the IO field 
together with its properties are copied.

These two methods can also be used for storing an object in a library. Project libraries and the 
objects contained there are migrated during migration and can be used in WinCC.

In WinCC, however, only one copying method is available. With regard to tags, it functions like 
"simple copy" in WinCC flexible. With regard to graphics, graphics lists and text lists, it functions 
like "copy" in WinCC flexible.

If you stored objects with references to tags in a library in WinCC flexible, you must reconfigure 
the referenced objects when using them in WinCC.

Installing East Asian project languages on a PC without Asian operating system
If you select an East Asian project language on a PC that does not have an Asian operating 
system installed, the default font is marked as invalid in the "Runtime settings > Language & 
font" editor.

To resolve this problem, open the "Regional and Language Options > Languages" dialog in 
the Control Panel and select the "Install files for East Asian languages" option.

Transferring licenses to a panel on 64-bit operating systems
If you are running a 64-bit operating system and the "Edit > Connect target systems > Connect 
HMI device" menu command is not available in Automation License Manager, open command 
line input and run the following command with administrator rights:

"%WINDIR%\system32\RegSvr32.exe" "%CommonProgramFiles%\siemens\AlmPanelPlugin
\ALMPanelParam.dll"

Installation sequence for Startdrive
When you install Startdrive on a PC, adhere to the following installation sequence:

● Install STEP7 V12.0.

● Install Startdrive.
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SIMOTION
SIMOTION is not supported with WinCC V12 SP1.

Security settings during installation
When you install WinCC V12, security settings are changed in your operating system. 

The security settings in question are listed during the installation. 

You must confirm the changes to the security settings.

If you make changes to your operating system after the installation, the changes to the security 
settings made by the installation of the TIA Portal could be changed.

You can restore the changes to the security settings made by the installation of the TIA Portal:

"Start > All Programs > Siemens Automation > Security Controller > Restore settings"

SQL instance of WinCC V12
If you have installed a WinCC V11 product and you wish to install a WinCC V12 product, you 
must uninstall all WinCC V11 products and the WinCC instance of SQL Server 2005 one after 
the other before the installation.

A new WinCC SQL 2008 instance is installed with the installation of WinCC V12.

3.3 Migration

Contents
Information that could not be included in the online help and important information about 
product features.

Changing the names of alarm classes
In contrast to WinCC flexible, the names of the predefined alarm classes are not dependent 
on the user interface language currently in use. During migration, the names of the alarm 
classes are assigned as follows:

WinCC flexible WinCC
Error Errors
System System
Warnings Warnings

The display names of the alarm classes can be changed as necessary after migration.
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Project languages in WinCC
WinCC V12 does not support all project languages that were available in WinCC flexible, such 
as Arabic. If you receive an empty project as the result of your migration, you may want to 
check the set editing language. Do not set the project languages that are not supported as 
editing language in the source project. Proceed as follows:

1. Open the project with WinCC flexible.

2. Change the editing language to English, for example.

3. Save the project.

4. Restart the migration.

Objects with object references in the project library
Two copying methods can be used in WinCC flexible. 

● With "simple copy", a WinCC flexible screen including an IO field, for example, is copied. 
Only the object name of a tag configured on the IO field is copied, as this is a reference.

● With "copy", a screen, an IO field contained there and a tag configured on the IO field 
together with its properties are copied.

These two methods can also be used for storing an object in a library. Project libraries and the 
objects contained there are migrated during migration and can be used in WinCC.

In WinCC, however, only one copying method is available. It functions like "simple copy" in 
WinCC flexible.

If you have stored objects with references to other objects in a library in WinCC flexible, you 
must reconfigure the referenced objects when using them in WinCC.

Migrating an integrated project with ProTool objects
The "PROTOOL option package(s) missing in STEP 7" error message output during migration 
of a WinCC flexible project that is integrated in STEP 7 indicates that WinCC flexible 2008 
SP3 is installed on your system. Moreover, the project still contains objects that were 
configured using ProTool. Do not open the project with WinCC flexible 2008 SP3! Proceed as 
follows to migrate the project:

1. Copy the project to a computer on which WinCC flexible 2008 SP2 and STEP 7 are installed.

2. Open the project in the SIMATIC Manager.

3. Remove all ProTool objects from the project.

4. Execute the "Save as" command in the "File" menu.

5. Activate the option "With reorganization" in the "Save project as" dialog.

6. Click OK.

7. Copy the project back to the original computer.

8. Restart the migration.
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Migrating a WinCC V7 project with "Chinese (Taiwan)" Runtime language
If your WinCC is installed with support for the "Chinese" user interface language, the texts and 
report layouts of the "Chinese (Taiwan)" Runtime language will not be included when you 
migrate WinCC V7 projects. Migrate such projects using the Migration Tool, or a PC that 
contains a WinCC setup without "Chinese" user interface language.

Progress bar
As long as the progress bar still shows a value of 100 %, the software is still busy running 
remaining tasks such as the closing of references. The software will not respond to user input 
while this status is given.

Principle
When you open a V11 project with a V12 version, it will no longer be possible to open this 
project with an older version afterwards.

Managing third-party ActiveX controls
The migration also supports third-party ActiveX controls. However, the controls must be 
registered in the operating system. If an ActiveX control is not registered, migration is canceled.

If you save a project with the migration tool and perform the migration yourself on another PC, 
the controls must also be registered on this PC.

Language switching in RT
Upgrading the project from V11 to V12 and migration of WinCC V7.0 SP3 to V12: 

If you have used a script to program a language change to Chinese (PRC) in V11 or V7.0 SP3 
with LCID, language switching to Chinese (PRC) in runtime no longer works after upgrading 
or migrating.

Change the LCID in script from "1028" to "2052".

Migrating integrated projects with alarm views 
An alarm view is enabled with all alarm classes in an integrated project. The alarm classes are 
disabled during migration of the project.
Once the migration of the project is completed, check the settings in the alarm view. 
Enable the require alarm classes in the Inspector window of the alarm view if needed under 
"Properties > General".

Migrating projects from WinCC V7
We recommend a 64-bit operating system for the migration of extensive projects from WinCC 
V7.0 SP3.
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3.4 Engineering System

3.4.1 Screens and Screen Objects

Contents
Information that could not be included in the online help and important information about 
product features.

Text format of output fields in alarm text
It is not possible to underline tags and text list entries.

Copying display objects between two projects or two devices
In Project_1 configure an alarm window in the Global Screen, for example. You copy the alarm 
window and paste it in the Global Screen in Project_2.             

The enabled alarm classes are partly not enabled in the alarm window after pasting.

This behavior applies to the following display objects:

● Alarm window

● Alarm indicator

● Alarm view

Representation of the cross-references in the Inspector window
The Inspector window displays objects used by a screen object in the "About > Cross-
reference" tab.

A screen is open and an object selected. You are using an HMI tag at the object as process 
tag.

The object and the linked HMI tag are displayed in the cross-references. All locations of use 
of the object and the HMI tags are listed.

If the HMI tag is interconnected with a PLC tag or a DB tag, then the locations of use of the 
interconnected PLC tag or DB tag will be displayed.     

Event names in case of alarms in the "Info" tab of the Inspector window
In some alarms of the Inspector window the event names in the "Info" tab will deviate from the 
names in the "Properties" tab.       
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Name in the "Properties" tab of the Inspector 
window

Name in the "Info" tab of the Inspector window

Cleared ClearScreen
Loaded GenerateScreen
Enable Activate
Change Change
When a dialog is opened ONMODALBEGIN
When a dialog is closed ONMODALEND
User change PASSWORD
Screen change SCREEN
Disable Deactivate
Press Press
Outgoing Going
Incoming Coming
Limit "high limit error" violated AboveUpperLimit
Limit "low limit error" violated BelowLowerLimit
Click Click
Loop-In-Alarm LoopInAlarm
Release Release
Alarm buffer overflow OVERFLOW
Acknowledge Acknowledgement
Runtime stop Shutdown
Press key KeyDown
Release key KeyUp
Switch ON SwitchOn
Switch OFF SwitchOff
Value change Change value

Dynamization of object properties in a group
The dynamization of properties for all objects of the group which have these properties is not 
possible in a group. In WinCC V12, the properties of the objects belong to a group can only 
be dynamized for each object itself. 

Illegible characters in Runtime Professional
With Runtime Professional, only characters belonging to the language area which is defined 
with the operating system setting "Language for non-Unicode programs" can be displayed on 
the target system. Texts with characters from other language areas can, however, also be 
configured in the project.

Illegible characters may occur in the Engineering System with the objects text field, symbolic 
I/O field, gauge and slider if the settings in the operating system relating to "Language for non-
Unicode programs" do not match the selected editing language and the objects are displayed 
in a different design than "WinCC Classic". The characters are displayed correctly in the 
Inspector window and the "Project texts" editor.
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Therefore, first check in the Control Panel under "Regional and Language Options > Advanced" 
whether the setting for "Language for non-Unicode programs" is the same as the editing 
language. Otherwise, you can check or change the correct texts in the Inspector window or 
the "Project texts" editor.

Faceplates
Faceplates cannot be rotated or mirrored.

Persistence with display objects in WinCC Runtime Professional
The objects f(t)-trend view, f(x)-trend view, alarm view, recipe view, table view and value table 
have settings for the persistence of online configurations. If you have configured "Persistence" 
for "Online configuration" and "Keep changes" for "Reaction to screen change", you can make 
changes to the configuration dialogs in runtime which will be retained after a screen change 
and after runtime is exited.

However, online configurations for the settings mentioned cause changes to the configuration 
of the objects in the Engineering System to only be applied in Runtime if you recompile the 
device with the command "Compile > Software (rebuild all)".

Basic Panels, OP73, OP77A and TP177A: Displaying texts in runtime 
The default font selected in the "Runtime settings > Languages & font" editor has an effect on 
the display of texts in runtime. 

Text entries may be truncated if you selected an unfavorable font size or style.

This setting possibly has an effect on the following text entries:

● Tooltips

● long alarm text

● text in the dialogs

Tab sequence in screens with faceplates
If you configured a tab sequence in screens with faceplates in WinCC V12 or WinCC V12 SP1, 
you should check the tab sequence of these screens in WinCC V12 SP2. The tab sequence 
may have been changed in both the screen and the faceplate.

Tag prefix of a screen window in WinCC Runtime Professional
The objects of the "Controls" palette do not support the tag prefix that can be configured for a 
screen window.

I/O field with "decimal" display format and format pattern without "s" prefix
You have linked a process tag to an I/O field. The I/O field is assigned the "decimal" display 
format.     

You may select a signed or an unsigned display format.
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A "Format pattern" setting without "s", e.g. "999" has the following effects:

1. You cannot set negative values using the I/O field in Runtime.

2. If the tag assumes a negative value, the I/O field generates a two's complement and a 
corrupted positive value is output.

Trend view on Basic Panels
The trend view buttons are not displayed on Basic Panels. You can operate the trend view 
using the function keys of the HMI device that are assigned corresponding system functions.

Displaying controls in protocols
A project with WinCC V11 SP2 with Update 4 or earlier is upgraded to WinCC V12.

In this process, it may happen that archive data is not displayed in controls for protocols.

The following controls are affected:

● f(t) trend view

● f(x) trend view

● Table view

Remedial measures for f(t) trend view and f(x) trend view

1. In the control, select "Properties > Properties > General > Display > Online". 

2. Recompile your project.

3. Load the project onto your HMI device.

Remedial measures for Table view:

1. In the control, select "Properties > Properties > General > Upon opening screen > Start 
update". 

2. Recompile your project.

3. Load the project onto your HMI device.

Grouping of screen objects
When you group screen objects in WinCC, performance problems can arise in WinCC in the 
case of large nesting depths.

Status/Force
The "Status/Force" screen object is enabled for the following controllers:

● SIMATIC S7-300

● SIMATIC S7-400
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ActiveX and .NET controls
ActiveX and .NET controls are always positioned in the foreground in runtime. 

The configuration of ActiveX and .NET controls on levels is not supported.

Frame line of rectangles
In a WinCC V7 project, you have configured a rectangle with the settings "Line weight = 1" 
and "Draw insider border = yes".

You then migrate the WinCC V7 project to WinCC V12.  To have the rectangle displayed 
correctly, proceed as follows. 

1. Open the Inspector window of the rectangle.

2. Open the property list.

3. Disable "Widen border line inwards".

Graphics in faceplates
You have added a graphic display in a faceplate and defined the "Graphic" property as the 
interface of the faceplate. The "Graphic" property can now be made dynamic using the interface 
of the faceplate instance.
Use the following notation to address the property with a screen via a script:
"..\\..\\screen name".

Assigning dynamic properties to instances of a faceplate type in a group
You can assign dynamic properties to instances of a faceplate type in an object group. The 
properties of an instance are also displayed as properties of a group. The individual 
dynamization processes with tags, scripts or animations of a group are not displayed in 
Runtime.

System diagnostics indicator for RT Advanced
You can find the library object "Diagnostics indicator" in the library "Buttons and Switches > 
DiagnosticsButtons (Comfort Panels)". The object can also be used for devices with RT 
Advanced.

Preview in screen window
You use your own designs with shadow for screen objects. The can display the screen objects 
in a screen window.
The shadows of the screen objects are not displayed in the preview of the screen window. The 
response occurs only in the Engineering System. It is displayed correctly in Runtime.
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3.4.2 Tags and connections

Contents
Information that could not be included in the online help and important information about 
product features.

Tag names
HMI tag names may not start with the character @.

Display of deleted array elements at location of use of HMI tags
The locations of use of HMI tags, such as the process value of IO fields, are usually indicated 
by the tag name. If the element of an array tag is used, then the tag name will be extended by 
the index of the array element indicated in brackets.

If a used tag is no longer included in the project, then the tag name will still be displayed at the 
location of use. The field will be displayed with a red background to indicate the missing tag. 
If a used array element or the array tag is no longer present, then only the index of the array 
element will be displayed in brackets. The tag name will not be displayed. The field is 
highlighted in red. You can no longer identify the name of the associated array tag based on 
the location of use in this instance.

If you do not know which array tag was linked to this location of use, then it may be necessary 
to link the array element once again.

If a tag or array tag was created based on a reference, then the selected reference will be 
closed automatically.

If an HMI tag is connected with an array element of a PLC tag and the PLC tag does no longer 
exist in the project, then the same behavior will take place in the "HMI tags" editor.       

Array tags as list entry of multiplex tags
You can use the array tags of the Char data type just like the tags of the String data type.       

The use of an array tag of the Char data type as list entry of a multiplex tag in the "HMI 
tags" editor is not supported. 

Multiplexing tags on a Basic Panel
If you multiplex a tag with an external tag on a Basic Panel, the address is read from the PLC 
in runtime during the first read cycle. The value of the address read is not available until the 
second read cycle.

Runtime Advanced and Panels: Importing array elements and structure elements
Array tags and structure tags are always imported in full with all elements. The elements of 
the array tags and structure tags are not filled further during import.
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A new tag is created if the name of a tag corresponds to the name of an array or structure 
element in the import file.

Example:

The import file contains an array tag called "Otto" with 10 array elements. The array elements 
are then called Otto[1], Otto[2], for example.

If the import file contains a tag called "Otto[1]", the first element of the array tag will not be 
filled. Instead, a new tag will be created in the Engineering System.

Local ID of HMI connections
You cannot edit the "Local ID" value in the HMI connection properties. You need the local ID, 
for example, for communication by way of AR_SEND. To enable usage of the "Local ID" for 
communication, proceed as follows:

1. Open the network view in the "Devices & Networks" editor.

2. Click "Connections".

3. Select an S7 connection.

4. Select the "Add new connection" command in the shortcut menu of the PLC.

5. Click on the interface.

6. Specify the "Local ID (hex)".

7. Click "Add" and then "Close".

8. Select "Properties > General" from the partner area of the Inspector window and enter the 
IP address of the HMI device for the new connection.

9. Configure the necessary raw data tags for communication in the HMI device.

Tags with the DTL data type
Tags that use the "DTL" data type element by element, can only be used as read-only.

3.4.3 Alarm system and alarm displays

Contents
Information that could not be included in the online help and important information about 
product properties.

Displaying special characters in alarm texts
When configuring alarm texts, a fixed character set is used in the Engineering System. This 
character set allows you to use numerous special characters in alarm texts.     
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Language-dependent fonts are used in runtime to display the texts, for example MS PGothic, 
SimSun. The fonts used in runtime do not support all special characters. As a result, some 
special characters are not displayed in runtime.

Use of multiplex tags in output boxes with alarm texts
It is also possible to use multiplex tags in the output boxes of alarm texts in the engineering 
system. During runtime, this leads to an incorrect display of the alarm, because the use of 
multiplex tags is not supported by the basic panels.     

Parameters in user alarms
Contrary to the information in the online help, it is not possible to configure parameters for user 
alarms.
The menu command "Properties > Properties > Alarm parameters" is not available in the 
Inspector window.

3.4.4 System functions

Content
Information that could not be included in the online help and important information about 
product properties.

The "SimulateTag" system function on Basic Panels
If you use the system function "SimulateTag" with a short cycle time on a Basic Panel, the HMI 
device may be overloaded.

3.4.5 Recipes

Contents
Information that could not be included in the online help and important information about 
product features.

Arrays in recipe elements
If you have configured both an array as well as the elements of this array for recipe elements 
of a recipe, the loading of data records aborts with the following error message: "290055: Import 
of data records aborted with error"

Use either the array or just the array elements for recipe elements of a single recipe.
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3.4.6 User administration

Contents
Information that could not be included in the online help and important information about 
product characteristics.

SIMATIC Logon for WinCC Runtime Advanced and Panels
When you use SIMATIC Logon to manage access to a panel or a device with WinCC Runtime 
Advanced, you must note that the characters [/] and [\] cannot be used in the names of Windows 
user groups or Windows users.

3.4.7 Communication

Contents
Information that could not be included in the online help and important information about 
product features.

Connection interruptions with Mitsubishi PLCs
After multiple connection interruptions, a situation may arise where all the connection 
resources of the Mitsubishi PLC are in use and the connection can no longer be established. 
It is recommended to check these connection resources in the PLC program of the PLC and 
also to enable them again.   

Area pointer "Date/time" or "Date/time PLC"
If you use the area pointer "Date/time" or "Date/time PLC" in communication with an S7-1200, 
you must use "DTL" data type in the configuration of the PLC.     

Accuracy of the "DTL" data type
The "DTL" data type supports time information down to the nanosecond range. Because panels 
only support time information down to the millisecond, you may encounter the following 
restrictions when using the area pointers:   

● Area pointer "Date/time"
For the transmission of time information from a panel to the PLC, the smallest unit of time 
is 1 millisecond. The value range from microseconds to nanoseconds of the "DTL" data 
type is filled with zeros.

● Area pointer "Date/time PLC"
For the transmission of time information from a PLC to a panel, the range from 
microseconds to nanoseconds is ignored. The time information is processed on the panel 
down to milliseconds.
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Limited number of possible HMI connections
An error message is displayed during compilation of a device indicating that the configuration 
of the HMI connection in the "Devices & Networks" editor is invalid. The reason may be that 
the maximum number of possible connections of the HMI device or PLC has been exceeded.

Check the maximum number of available connections. Consult the device manuals of the 
devices you are using.

Routed communication with S7 300/400
Communication from connection partners in various different subnets can be routed via the 
following connections: PROFINET, PROFIBUS, MPI.

Using PROFINET IO with panel HMI devices
When using PROFINET IO to connect the direct keys and LEDs of HMI devices to the PLC, 
you can define an offset for the address area of the inputs and outputs during configuration in 
HW Config.

The following restriction applies when you use a PROFINET IO-capable CPU of the 400 series 
with one of the HMI devices listed below:

The offset for the start of the address area of the inputs cannot be bigger than the offset for 
the start of the address area of the outputs.

The restriction applies to the following HMI devices:

● OP 177B

● OP 277

● Mobile Panel 177

For the configuration of the address parameters, open the PLC with the CPU of the 400 series 
in HW Config. Select the HMI device connected via PROFINET IO in the station window of 
HW Config. A table with the properties of the HMI device is displayed at the bottom of the 
station window in the detail view. Select the line containing the addresses of the HMI device 
in the table and open the object properties using the shortcut menu.

Select the "Addresses" tab in the "Object properties" dialog. Configure the offset for the inputs 
under "Inputs > Start". Configure the offset for the outputs under "Outputs > Start".

Exceeding value ranges with Mitsubishi MC and Mitsubishi FX
With some data types, the Mitsubishi MC and Mitsubishi FX communication drivers do not 
check whether the value of a recipe tag exceeds the value range of the PLC tags. The data 
types affected are:

● 4-bit block

● 12-bit block

● 20-bit block

● 24-bit block

● 28-bit block
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Coordination area pointer in an OPC connection
In principle, the coordination area pointer can be used eight times in an OPC connection. If 
you have configured an OPC connection and automatically create another OPC connection 
using "Add", the coordination area pointer is only displayed once in the newly created 
connection. In this case, you should change the communication driver of the connection. If you 
then set OPC again as the communication driver, the area pointer coordination can again be 
used eight times.

Communication resources: SIMATIC S7 1200         
The SIMATIC S7 1200 controller provides six communication resources for HMI 
communication.

The number of HMI connections that you can actually configure depends on the HMI devices 
that you connect with the SIMATIC S7 1200. 

One HMI Panel occupies one communication resource per connection.

Changing IP settings and device name of a controller in the Control Panel of the HMI device
The Control Panel is open in the "Service and Commissoning > IP-Adaptation" menu on the 
HMI device. If you want to change the IP settings or the device name of a controller, note the 
following:

In the Engineering System, you need to have activated the following options in the Inspector 
window of the controller under "Properties > General > PROFINET interface > Ethernet 
addresses" beforehand:
- "Set IP address using a different method" and
- "Set PROFINET device name using a different method".
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HMI connections in WinCC V12
HMI connections to SIMATIC S7-1200 PLCs with firmware version lower than V2.0 cannot be 
made in WinCC V12.

Connections via PROFIBUS DP
When a connection between a PLC and an HMI device via PROFIBUS DP is interrupted and 
then re-established, sporadically all other PROFIBUS DP connections in the communication 
network are interrupted and re-established.

De-energize the disconnected station before reconnecting it.

"Set the IP suite (address) of the PLC in the Control Panel" with SIMATIC S7-1200 V1
The function "Set the IP suite (address) of the PLC in the Control Panel" has not been approved 
for the following PLCs:

● SIMATIC S7-1200 V1

Switching a connection
A connection may be interrupted when it is switched from a HMI device control panel to a 
SIMATIC S7-300/400, SIMATIC S7-1500 or SIMATIC S7-1200.

Note the following settings in the SIMATIC S7 1500 or SIMATIC S7 1200 controllers: 

● Absolute addressing of tags

● The "Disable PUT-GET communication" option must be selected

● The "Complete protection" protection level may not be set

3.5 Compiling and loading

Contents
Information that could not be included in the online help and important information about 
product features.

Compiling and loading
If internal errors or warnings occur during compiling, compile the complete project using the 
command "Compile > Software (rebuild all)" in the shortcut menu of the HMI device.

Before you start productive operation with your project, compile the entire project using the 
"Compile > Software (rebuild all)" command from the shortcut menu of the HMI device.

If you are using HMI tags that are connected to the control tags in your project, compile all 
modified blocks with the command "Compile > Software" in the shortcut menu before you 
compile the HMI device.
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Saving the WinCC project
If you save a project in WinCC using the "Save As…" command, this has no effect on the name 
of the Runtime projects generated for the devices. If you do not adapt the destination path of 
the devices in the "Extended download to device" dialog, the Runtime projects on the target 
devices will be overwritten.

Settings for update of operating system
If you select the command "Online > HMI device maintenance > Update operating system" 
from WinCC, you cannot change the settings such as the type of PG/PC interface or baud 
rate. The settings used during the last download are always used.

To make changes to the settings, open the "Extended download" dialog using the "Online > 
Extended download to device" command and change the settings. When you click the "Load" 
button the changed settings are saved.

Alternatively, you can perform an update of the operating system with changed settings with 
ProSave. You start ProSave via the Windows Start menu "Siemens Automation > Options and 
Tools > HMI Tools > SIMATIC ProSave".

Incorrect installation of ProSave
If you receive an error message during installation of ProSave when loading data to a target 
device or maintenance of an HMI device, then you cannot remedy this error using the repair 
function of setup. Remove ProSave via the Control Panel. Then start setup and install the 
"ProSave" component again.     

Checking the address parameters
During compilation of an HMI device in the project tree with the command "Compile > Software" 
in the shortcut menu, the address parameters of the HMI device, such as the IP address, will 
not be checked. If you want to ensure that the address parameters are checked as well, you 
will have to compile the HMI device in the "Devices & Networks" editor of the toolbar.   

Error message when downloading data to the PLC
A panel and a PLC are connected and communicating with other. 

If a tag is accessed while downloading data from the panel to the PLC, an error message is 
displayed on the panel.     

Delayed reaction in the "Extended download to device" dialog
If the settings in the "Extended download to device" dialog for "Type of the PG/PC interface" 
and "PG/PC interface" do not match the settings on the HMI device, this can result in the 
application not responding for up to a minute.
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Extended download with an S7-1200 and a Comfort Panel
An S7-1200 PLC and a Comfort Panel are located in the same physical network as the PG/
PC. You open the "Extended download to device" dialog for the Comfort Panel. 

If you activate the option "Show all accessible devices", it may occur that the application stops 
responding.   

OP77A, OP73, TP177A: Loading projects
When loading a project to an HMI device, it can happen that Runtime is not automatically 
ended, even though "Remote Transfers" is activated in the Panel.

If this happens, stop Runtime and manually set the transfer mode on the HMI device.       

Loading a SIMATIC HMI application to a PC station
The following circumstances ca n lead to an error message during the first load of a SIMATIC 
PC station:

● A SIMATIC HMI application is configured in a PC station in the project

– WinCC Runtime Advanced

– WinCC Runtime Professional

– WinCC Standby

– or WinCC Client

● The property "S7RTM is installed" is activated.

Before you load a SIMATIC PC station for the first time, select the configured device HMI_RT 
(WinCC...) in the project tree. Open the "Extended download to device" dialog and select the 
appropriate interface and parameter settings. Click "Load".

You then load the PC station as normal.     

Project transfer via USB
If you have connected more than one HMI device via USB to your configuration PC, project 
transfer is only possible to the last connected device.

Delta download capability
If you make changes to a UDT, is the capability to perform a delta download of the Runtime 
Professional project lost. 

Compile the full project again.

Opening project files
When you run "HmiIRTm.exe", a dialog opens asking if you want to open the project file (.fwc). 

The following options are available to you: 
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● "Yes": A dialog opens allowing you to select a project file (.fwc).

● "No": The dialog closes.

3.6 Runtime

3.6.1 Notes on operation in Runtime

Contents
Information that could not be included in the online help and important information about 
product features.

Special characters in the user view
Special characters, such as / " § $ % & ' ?, are not permitted when entering a name or the 
password in the user view.     

Language behavior - Layout of on-screen keyboard
The layout of the on-screen keyboard is not switched when the runtime language changes.     

Tag values exceed the maximum length     
You enter a character string in a string tag via an I/O field. If the character string exceeds the 
configured number of tags, the character string will be shortened to the configured length.

Empty message texts
Runtime is running with a project. The project is saved on a network drive.

In the event of interruptions to the network drive connection, Runtime may attempt to load 
message texts from the network drive.

In the event of disconnection, the alarm window or the alarm view remains empty.

To avoid this, copy the project to a local drive before the starting the project in Runtime.

Complete download in Service mode
If you need to perform a "complete download" to the OS in Service mode from the engineering 
station, Runtime automatically stops and then starts again. 

The project is then no longer in Service mode.

In this state, the power supply is interrupted and WinCC Runtime no longer starts automatically 
on the OS.
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Remedy: 

1. Switch the project manually to Service mode after you have performed the "complete 
download". 

2. Close the project manually.

3. Activate Service mode.

4. Start Runtime again using the surrogate icon in the taskbar.

3.6.2 Notes on operation of panels in Runtime

Contents
Information that could not be included in the online help and important information about 
product features.

Using the mouse wheel in Runtime
The use of the mouse wheel in Runtime is not supported on all panels.   

Basic Panels: Connections to S7-1200 and S7-1500 with Backup/Restore
If you use the "Backup/Restore" function, a maximum of two connections from Basic Panels 
to the controllers are possible at any given time.

● SIMATIC S7-1200

● SIMATIC S7-1500

Basic Panels: Backup on the memory card of the PLC
Create the backup file "A.psb" on the memory card of the PLC. An error, for example a 
connection break, occurs when creating the backup.
This will create a corrupt file on the memory card of the PLC. Such a file has "~$" as prefix. 
Delete the file with the prefix "~$" if you want to save a backup again under the same name 
"A.psb".

Basic Panels: Panel Data Storage and S7-1500F
The "Panel Data Storage" PDS function cannot be used on Basic Panels in conjunction with 
S7-1500F when the password for the protection level "Full access incl. fail-safe" is used.

Upgrading Basic Panels to WinCC V12
Before you upgrade Basic Panels from version V11 to version V12, transfer the image of the 
V11 SP2 Update 5 or higher to the devices.
In the "SIMATIC ProSave [OS Update]" dialog, select the setting "Reset to factory settings". 
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In this way, you always start a functional update of the image.
Affected devices:

● KP300 Basic mono PN, 

● KP400 Basic color PN 

● and KTP400 Basic color PN.

3.7 HMI devices

3.7.1 Notes on HMI devices

Contents
Information that could not be included in the online help and important information about 
product characteristics.

If the PC goes into standby or hibernate mode while the transfer is in progress, the panel status 
after interruption of the transfer is not defined.

Multi-key operation
Unintentional actions can be triggered by multi-key operation:         

● When you are using a key device, you cannot press more than two function keys at the 
same time.

● When you are using a touch device, a standard PC or a panel PC, you can only press one 
function key or button at the same time.

TS Adapter with Ethernet interface
If an HMI device is connected via Ethernet and a TS adapter, it can not be reset to factory 
settings.   

Simulation of the Basic Panels
Use an output field in an alarm text to output an external tag. The content of the output field 
will always be displayed with "0" during simulation.   

Simulation with real PLC connection
The access point used by the simulation is independent from the settings of the Engineering 
System and can only be altered in the Control Panel with the "Setting PG/PC Interface" tool. 
If the PLC connection is terminated right after the start of the simulation with alarm 140001, 
you should check the access point used by the simulation with "Setting PG/PC Interface".
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1. Double-click "Setting PG/PC Interface" in the Control Panel. A dialog opens.

2. Select" "S7ONLINE" in the "Access point of application" field as standard for HMI.

3. Select the interface in the "Interface Parameter Assignment Used" area.

4. Exit the dialog "Setting PG/PC Interface" with OK 

Loading of projects without recipe data records
You are using recipes in a project. You transfer the project to a Basic Panel without recipe 
data records. 

You may encounter inconsistencies if you have altered the structure of the recipe in the 
Engineering System and the device already held recipe data records.

Check the consistency of the data records in this case. The device will not issue a note for all 
structural changes.       

Floating point numbers on MP 277, MP 377, TP 177B 4'' and CP4
Only floating point numbers in the range from 10-293 ... 10+307 are displayed correctly on the 
HMI devices MP 277, MP 377, TP 177B 4'' and CP4. If the tag value is outside this range, it 
is displayed as 0.

USB device driver under Windows XP
If a configuration PC with Windows XP and a Comfort Panel are connected via USB, the S7-
USB driver may be reinstalled when the HMI device is restarted. The device settings may in 
this case not be restored.

Mobile Panels V2
If you use Mobile Panels V2 in a project, it is not possible to open the project with WinCC V11 
SP1. This affects projects with the following devices:

● Mobile Panel 277F IWLAN (RFID Tag)

● Mobile Panel 277F IWLAN V2

● Mobile Panel 277 IWLAN V2

"Zone ID/Connection point ID" tag of a Mobile Panel 277 IWLAN V2
The tag used for the "Zone ID/Connection point ID" must be of data type INT for Mobile Panel 
277 IWLAN V2 devices. Adapt this data type if necessary when migrating a project.

HMI devices with operating system Windows CE 5.0 or higher
Owing to a modified client-server communication security setting, the time difference between 
the HMI device (client) and PC (server) must not exceed 1 day. If you back up recipe data from 
the HMI device on a network drive, for example, make sure that the time is set correctly on the 
PC (server) and the HMI device (client).
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HMI devices with high communication load
S7 Diagnostics should be enabled if a Panel is assigned many connections to PLCs or other 
HMI devices. Otherwise, you will risk overload on the Panel.

Device replacement in the Engineering System
In the Engineering System, you replace a device with configured LED keys with a device 
without LED keys. Runtime start fails after you have transferred the project data to the device. 

For this reason, delete the LED key configuration before you replace the device.

Restrictions for the HMI device, MP 377 15" Touch daylight readable
The following functions are not supported in WinCC V12 for the MP 377 15" Touch daylight 
readable HMI device:

● Option: Sm@rtServer

● System function: SetAndGetBrightness

● Direct keys

Upgrading Basic Panels to WinCC V12
Before you upgrade Basic Panels from version V11 to version V12, transfer the image of the 
V11 SP2 Update 5 or higher to the devices.
In the "SIMATIC ProSave [OS Update]" dialog, select the setting "Reset to factory settings". 

In this way, you always start a functional update of the image.

Affected devices:

● KP300 Basic mono PN 

● KP400 Basic color PN

● KTP400 Basic color PN

Connection switch in the Control Panel with Basic Panels
If you use the "Override protected connection information" function, the following restriction 
applies:

You cannot perform a connection switch in the Control Panel of a Basic Panel from a PLC 
without a protection level to a PLC with a "Complete protection" level.
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HMI device, 59
Recipe data record, 59

TRCV_C, 26
TS adapter, 58
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Turkish regional and language options, 10

U
USB card readers, 8
USB network card, 22
User view

Permitted characters, 56

W
Watch table

"Enable peripheral outputs" function, 29
Loading data blocks during an active control job, 
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Multiple access to the same CPU, 29

WinCC V7.0 SP3, 41
Windows Server 2003, 10
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